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ASSESSING SATURATION-DEPENDENT MATERIAL 

PROPERTIES IN POROUS MEDIA 

SatuDict is the GeoDict module for the computation of saturation-dependent material 

parameters in porous media. In many applications, the porous media is partly 
saturated, so that part of the pore space is filled with water and part with air, gas, 

or oil. Oil-water, water-air, or other two-phase systems are possible. Generally, one 
of the fluids preferably wets the media surfaces and is therefore called the wetting 
phase, whereas the other fluid, with less affinity for the media, is called the non-

wetting phase. It is not unusual that water is the non-wetting phase. 

SatuDict can calculate the phase distribution for the two types of phase 

displacement, namely Drainage and Imbibition.  

A Drainage displacement occurs where a non-wetting invading fluid enters the 
porous media and displaces a wetting fluid, which was saturating it.  

 

 

 

 

 

 

 

 

 

 

 

The opposite case, Imbibition, occurs when a wetting fluid invades the space 

around the material and the material surface, which had been occupied by a non-
wetting fluid, displacing it.  

Drainage process 

→→→→→→ 

Imbibition process 

→→→→→→ 
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Not only the pore size, but also the connectivity of the phases to a phase reservoir 

determines the final distribution of the phases and has to be accounted for. After 
Drainage, a residue of the wetting phase (Residual Wetting Phase) or, after 
Imbibition, a residue of the non-wetting phase (Residual Non-Wetting Phase) can 

remain trapped in the porous media. 

The mechanisms of the displacements in drainage and imbibition are quite different 

and the two cases should not be confused. Typically, in drainage the invading non-
wetting fluid only enters a pore if the capillary pressure is equal to or greater than 
the threshold pressure of that pore. The threshold pressure corresponds to the 

capillary pressure in the narrowest part of the pore. However, in imbibition at low 
injection rate the invading wetting fluid enters the narrowest pores before any other 

pore is considered. 

 

PORE MORPHOLOGY METHODS 

SatuDict uses several Pore Morphology methods to determine the distribution of 
the two phases inside the porous media.  

The Quasi-Static Pore Morphology Method [1] calculates the stationary 

distribution of wetting and non-wetting phases for a given capillary pressure and it 
is applicable when 

 gravity and viscous forces are negligible compared to capillary forces, 

 the material is homogeneous, i.e. there exists a well-defined contact angle 
between material surface and phase boundary, and 

 only two-phase systems are considered. 

 

For such systems, the pore space accessible to the non-wetting phase is given by 

the Young- Laplace equation, where 𝝈 is the surface tension, 𝜶 the contact angle, Pc 

is the capillary pressure and r defines the minimum radius of accessible pores. Thus, 

the problem is reduced to a purely geometrical problem, 

𝑟 =
2𝜎

𝑝𝑐
𝑐𝑜𝑠 𝛼 

The contact angle 𝜶 can be different at each solid phase inside the porous medium 

[3] and, thus, variable wettability can be incorporated. 

The Quasi-Static Pore Morphology Method has the drawback, that for a drainage 

simulation, the whole structure is filled instantly after the invading fluid passed the 
narrowest pore throat. For an imbibition simulation, the whole structure is filled 

instantly, if the invading wetting phase filled the biggest pore. Since GeoDict 2021, 
the Dynamic Pore – Morphology Method is therefore available in SatuDict. It 
allows for a dynamic simulation of the drainage and imbibition processes, even with 

non-monotonic capillary pressure curves. Like this, the capillary pressure can drop 
down during a drainage simulation when the non-wetting phase passes a pore-

throat. During an imbibition simulation, the capillary pressure is not monotonically 
decreasing, but can rise again, when the wetting phase passes a big pore. Even 
without the option of non-monotonic capillary pressure curves selected, several 

intermediate steps are computed for the same pressure value, to avoid instant filling 
of the whole structure.  
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With this new method, for imbibition processes, additionally, thin wetting layers can 

be considered by modified connectivity checks. Wetting residuals near the invading 
wetting phase front are always treated as connected. The distance from the invading 
wetting front considered for this modification is user-defined and constant during the 

simulation.  

In the following, an example of the resulting capillary pressure curve of a drainage 

simulation with all three methods is shown below.  

QUASI-STATIC PORE MORPHOLOGY METHOD 

With this method, the capillary pressure for a drainage simulation is monotonically 
increasing. At each simulation step, the capillary pressure is increased by a fixed 
value. This leads to the effect that large pores beyond small pore throats are filled 

at once when the pressure is high enough to pass the pore throat. 

For an imbibition simulation, the capillary pressure is monotonically decreasing. At 

each simulation step, the capillary pressure is decreased by a fixed value.This leads 
to the effect, that small pores beyond big pore bodies are filled at once when the 
capillary pressure is small enough. 

Both effects are visible in the capillary pressure curve and responsible for large 
saturation jumps. Thus, there are sometimes too less computed saturation points in 

the saturation range between 25% and 75%. In the example shown above, no 
saturation point is computed between a saturation of 40% and 60%.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This method is useful for the prediction at which capillary pressure the breakthrough 
occurs and provides detailed information about fluid distributions for high and low 

saturated structures. If the detailed fluid distribution at a broad range of saturations 
is of interest, this method should not be used anymore. However, for structures with 

a layered distribution of pore sizes, the method provides detailed fluid distributions. 
E.g. if pores are large at the top and getting smaller toward the bottom and a 

drainage process is simulated from top to bottom.  
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DYNAMIC PORE-MORPHOLOGY METHOD WITH MONOTONIC CAPILLARY 

PRESSURE 

For drainage simulations, the capillary pressure is monotonically increasing. At each 

simulation step, the capillary pressure may be increased or it can stay the same.  

For imbibition simulations, the capillary pressure is monotonically decreasing.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This method avoids large saturation jumps and provides many intermediate 

saturation steps. The interface between the two fluids is displaced by a small 
(interface) step size, defined in the Solver parameters. The method tries to move 

the interface according to this parameter. In the example shown, also in the range 
between 40% and 60% saturation, some intermediate saturation steps are 
computed and the wetting fluid invades without big jumps.  

This method predicts a more accurate fluid movement compared to the quasi-static 
pore morphology method. The performance of the method was increased for the last 

service packs of GeoDict 2021 and the runtimes with GeoDict 2022 are similar with 
the quasi-static method. 

This method should be used if a detailed fluid distribution at a broad range of 

saturations is of interest. 

However, certain physical phenomena, e.g., formation of water droplets above a 

fiber structure with large pore space at the top, cannot be modelled with this method. 
This requires that the capillary pressure can have a non-monotonic behavior. 
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DYNAMIC PORE-MORPHOLOGY METHOD WITH NON-MONOTONIC 

CAPILLARY PRESSURE 

For drainage simulations, the capillary pressure is non-monotonically increasing. At 

each simulation step, the capillary pressure may be decreased or it stays the same, 
if possible, otherwise the pressure is increased.  

For imbibition simulations, the capillary pressure is non-monotonically increasing. At 
each simulation step, the capillary pressure may be decreased of it stays the same 

if possible, otherwise the pressure is increased. 

If this method is selected, it provides two capillary pressure curves in the result file. 
One for the monotonic and one for the non-monotonic behavior, shown above for 

the example.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The non-monotonic method avoids large saturation jumps as well, but can predict 
many more intermediate saturation steps. It allows to model more complex physical 

phenomena, e.g. the formation of water droplets above a fiber strcture with large 
pore space at the top. The method is more precise than the other two methods, but 
also the runtime is higher. The interface step size is used in the same way as for the 

monotonic method, described above 
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SATUDICT COMPUTATIONS 

Saturation alters the values of material properties of the porous media, such as flow 

permeability, diffusivity, and thermal or electrical conductivity. These material 
properties (constant for one-phase systems) come to depend on its saturation.  

In the SatuDict GUI, these saturation-dependent properties are named as relative 
(Relative Permeability, Relative Gas Diffusivity, and Relative Thermal or Electrical 
Conductivity).  

Regarding the permeability, the values computed with SatuDict 2022 and displayed 
in the GDR result file include the relative permeability and the saturation-dependent 

permeability (shown as Effective Permeability under the Results-Report tab). See 
the GDR result file in detail below in page 47.  

The absolute permeability is given as the permeability of the completely saturated 

medium (K1, 𝑠 =  1), whereas the saturation-dependent or effective 

permeability is the permeability of the medium at given saturation levels (Ks, 𝑠 ∈
[0,1]). The permeability is 0 at saturation 0 (K0, 𝑠 = 0).  

The relative permeability is a dimensionless measure, defined as the ratio of the 

saturation-dependent permeability to the absolute permeability. The relative 
permeability must be between zero and one. 

𝐾𝑠

𝐾1
 ∈  [0,1] 

where Ks is the saturation-dependent permeability and 𝐾1 is the absolute 

permeability.  

SatuDict can be used to: 

 Determine the capillary pressure curve using the pore morphology method 
or the dynamic pore morphology method to evaluate the distribution of non-

wetting and wetting phases for a given (quasi-stationary) capillary pressure Pc 
and, in this way, determine the saturation s. The capillary pressure curve, Pc(s), 

is determined by repeating this calculation for a variety of capillary pressures. 
The capillary pressure curves for drainage and imbibition are usually not identical 
but show a hysteresis effect. 

 Determine relative and saturation-dependent (effective) permeability 
for different saturations. The pore morphology method can be used to determine 

the distribution of the phases (then it is assumed to be stationary) or saturation 
results of a previously simulated wetting process can be used. 

To calculate the permeability 𝐾𝑤 of the wetting phase, the non-wetting phase is 

treated as an unmovable obstacle. The flow calculation treats it as a solid.  

To calculate the permeability 𝐾𝑛𝑤 of the non-wetting phase, the wetting phase is 

treated as an unmovable obstacle.  

Thus, flow only takes place in the pores filled with the corresponding fluid, 

whereas the other pores are ignored. Specifically, no movement of bubbles is 
simulated. 

The permeability values are then determined as described in the FlowDict 2022 

handbook. The resulting permeability value is now dependent on the saturation.  

To determine the whole curve  𝐾𝑤(𝑠), it is necessary to calculate the permeability 

for several different saturations. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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To calculate the relative permeability, the module FlowDict is necessary. Without 

a licensed FlowDict module, this option is not accessible. 

 Calculate saturation-dependent (relative) gas diffusivity using the pore 
morphology method or results of a previously simulated drainage or imbibition 

process. SatuDict calculates the saturation-dependent diffusivity as in DiffuDict 
(see the DiffuDict 2022 handbook). It is assumed that there is no diffusion from 

the gas phase into the liquid phase and no transport of the gas within the liquid 
phase (no-flux boundary conditions). It is also assumed that Knudsen diffusion 
can be neglected. The saturation-dependent gas diffusion can be calculated for 

successive saturations based on the gas/liquid phase distributions from the 
simulated drainage. 

To calculate the relative gas diffusivity the module DiffuDict is necessary. Without 
a licensed DiffuDict module, this option is not accessible. 

 Determine saturation-dependent (relative) thermal conductivity, and 
resistivity index. SatuDict calculates the saturation-dependent thermal 
conductivity and the resistivity index as in ConductoDict (see [4] and the 

ConductoDict 2022 handbook. The thermal conductivity or the electrical 
conductivity of the structure materials and of the fluid phases, and the 

direction(s) of conduction, are entered. For each direction of interest, equations 
of purely diffusive heat transport are set, and solved. Advection or radiation is 
not considered.  

To calculate the relative thermal conductivity and the resistivity index, the 
module ConductoDict is necessary. Without a licensed ConductoDict module, 

these options are not accessible. 

The saturation process can be calculated and then visualized in various ways in the 
GeoDict Result Viewer from the result files saved in the project folder during the 

saturation simulation.  
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SATUDICT SECTION 

SatuDict starts when selecting Predict → SatuDict in the menu bar. The pull-down 

menu in the SatuDict section gives access to the choice of available computations: 
Capillary Pressure Curve, Relative Permeability, Relative Gas Diffusivity, 
Relative Thermal Conductivity, Resistivity Index and Predefined.  

 

 

 

 

 

 

 

 

 

 

 

The Wetting Parameters or Options for the SatuDict computations can be 

modified through the Solver Options’ Edit… buttons. 

 

When the parameters for the selected SatuDict computational process have been 

entered, clicking the Run button in the SatuDict section starts the computations. 

When recording a macro, the Record button becomes active and the Run button 

changes to Run & Record. 

The parameters entered in the Wetting Parameters or Options dialog boxes can 

be saved into *.gps (GeoDict Project Settings format) files and/or loaded from them. 
Remember to restore and reset your (or GeoDict’s) default values through the icons 
at the bottom of the dialog box when needed and/or before every SatuDict run. 

Resting the mouse pointer over an icon prompts a ToolTip showing the icon’s 
function. 
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CAPILLARY PRESSURE CURVE 

When selecting Capillary Pressure Curve from the pull-down menu, the Wetting 
Parameters needed for running this process can be entered (or modified) through 

the Edit... button.  

The name for the result file is entered in the Result File Name box. Keep the default 
name or rename it according to your current project, to differentiate the results of 

sets of SatuDict computations. The resulting GDR result file is placed inside the 
chosen project folder. 

The wetting parameters are grouped under four tabs: Saturation Experiment, 
Constituent Materials, Boundary Conditions, and Solver Parameters. 

SATURATION EXPERIMENT 

Under the Saturation Experiment tab, the parameters Experiment and 
Connectivity are included. Additionally, it can be selected to use the Dynamic 

Pore-Morphology Method and parameters for it can be set. 

EXPERIMENT 

During two-phase flow in a porous media, one fluid is displaced by another fluid. 
Imbibition occurs when a wetting fluid displaces a non-wetting fluid. Drainage 

occurs when a non-wetting fluid displaces a wetting fluid. The two processes are 
governed by different mechanisms and should not be confused. 
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CONNECTIVITY 

The pore size and the pore connectivity to the wetting phase (WP) reservoir or non-

wetting phase (NWP) reservoir determine the final distribution of the phases.  

Check Invading Fluid must be connected to a Reservoir to connect the invading 
phase continuously to a phase reservoir at a given spatial location (defined on the 

Boundary Conditions tab, see page 15). 

Check Replaced Fluid can leave a Residual if the replaced phase will leave a 

residual if not connected to a reservoir. 

Check Ignore Closed Pores to fill only the open pores with the invading phase. 
Open pores are connected to the inflow and outflow region. All pores not connected 

to the domain boundary (closed pores) are pores without fluid at the beginning of 
the simulation. These closed pores are ignored and considered as solid regions during 

the simulation. 

For Imbibition: 

 Uncheck Invading Fluid must be connected to a Reservoir to model the 

sudden appearance of the wetting phase as condensation on the surface of the 
material in the structure. The wetting phase spreads out and, thus, the non-

wetting phase is displaced from the material surface and disappears from the 
structure. This corresponds to Imbibition I in previous GeoDict versions. 
Replaced Fluid can leave a Residual cannot be checked in this case. 

 

 Check Invading Fluid must be connected to a Reservoir and uncheck 
Replaced Fluid can leave a Residual to model an imbibition process 

considering the displacing wetting phase continuously connected to a wetting 
phase reservoir at a given spatial location. The replaced non-wetting phase will 
leave no residual (Imbibition II in previous GeoDict versions). 

 

 Check Invading Fluid must be connected to a Reservoir and check 
Replaced Fluid can leave a Residual to model an imbibition process 
considering the displacing wetting phase continuously connected to a wetting 

phase reservoir and a residual non-wetting phase remaining trapped in the 
porous media during advancing of the wetting phase. This corresponds to 

Imbibition III in previous GeoDict versions. 

 

For Drainage: 

 Invading Fluid must be connected to a Reservoir cannot be unchecked for 
drainage simulations. The invading non-wetting phase is always connected to a 

reservoir. 
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 Uncheck Replaced Fluid can leave a Residual to model the drainage without 

residual wetting phase remaining in the porous media. This corresponds to 
Drainage I in previous GeoDict versions. 

 

 Check Replaced Fluid can leave a Residual to consider a residual wetting 
phase remaining trapped in the porous media, as the non-wetting phase invades 

the structure and displaces the wetting phase. This is Imbibition II of previous 
GeoDict versions. 

 

DYNAMIC PORE-MORPHOLOGY METHOD 

Check Use Dynamic Pore-Morphology Method to use this method for dynamic 
simulation of the drainage and imbibition processes.  

 

 

 

 

 

 

Select Non-Monotonic Capillary Pressure to allow that the capillary pressure can 

drop down during a drainage simulation when the non-wetting phase passes a pore-
throat. During an imbibition simulation, the capillary pressure can rise again, when 
the wetting phase passes a big pore. 

To consider a modified connectivity check for thin wetting layers, check Thin 
Wetting Layers and define a Thin Wetting Layer Distance in voxels. Like this, 

wetting residuals not more than the defined distance away from the invading wetting 
phase front are always treated as connected. In addition, new wetting residual layers 
may emerge in small pores near the invading wetting front. This option is only 

available for imbibition processes. 
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CONSTITUENT MATERIALS 

All material properties of wetting and non-wetting phase can be defined on the 
Constituent Material tab. 

CONTACT ANGLE MODE 

Depending on the number and type of solid phases, the Contact Angle Mode can 

be selected as: 

1. Constant Contact Angle. In this default setting, for the Pore Morphology 
method, a single (constant) contact angle is assumed between all solid materials 
and the wetting phase, and another constant contact angle between all solid 

materials and the non-wetting phase. The given contact angle is considered for 
the computation of the capillary pressure, but a contact angle of 0° is used for 

the distribution of the fluids! 

2. Multiple Contact Angle. For a more general Pore Morphology method, different 
(multiple) contact angles are specified for every solid material with the wetting 
phase and with the non-wetting phase. The contact angles of every material can 

be entered under the Contact Angle tab on the right-hand side below. The 
different contact angles are considered for the computation of the capillary 
pressure and for the distribution of the fluids. Surfaces of solid materials are 

assumed to be planar for this approach. 

3. True Contact Angle. In the same way as for Multiple Contact Angle, contact 
angles for every solid material with the wetting and the non-wetting phase can 
be defined. To inscribe fluids with a more accurate contact angle, the curvature 

of the surface of solid materials is considered. For contact angles near 90°, the 
artefacts occurring for the Multiple Contact Angle method are avoided. 
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INTERFACIAL / SURFACE TENSION 

Enter the Interfacial/Surface Tension between the wetting and the non-wetting 

phase or use the default value corresponding to the surface tension between water 
and air.  

INVADING FLUID AND REPLACED FLUID 

The Invading Fluid invades the current structure and displaces the Replaced 

Fluid. The invading fluid can be selected through the Material Selector dialog box, 
by clicking on the button for the material. 

The fluid displaced by the Invading Fluid is called Replaced Fluid and must be 

already present in the model of the structure currently in memory. Choose the 
replaced fluid from the pull-down menu. 

The Wettability is already assigned to the invading and the replaced fluid, 

dependent on the Experiment selected on the Saturation Experiment tab, see page 
9. For Imbibition, the invading fluid is the wetting phase, and the replaced fluid the 

non-wetting phase. For Drainage, the invading fluid is the non-wetting phase.  

MATERIAL AND CONTACT ANGLE 

The Contact Angle can be entered for all solid materials (after choosing Constant 
Contact Angle as Contact Angle Mode) or for each solid material separately (after 

choosing Multiple Contact Angle or True Contact Angle as Contact Angle Mode).  

On the Material tab, the material of each material ID can be selected, and the 

wettability for each fluid is shown. The Contact Angle tab shows which fluid will be 
replaced (here, Oil will be replaced). 
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The Wetting Phase CA (Contact Angle) and the Non-Wetting Phase CA values 
add up to 180 and they are adjusted automatically when changing one of the two 

values. The Wetting Phase CA must be less than 90°. 

 

 

 

 

 

 

 

Click the Material Report button to see 
the relevant parameters for the material 
with a selected ID. 

 

 

 

 

 

180º 

Non-Wetting Phase 

Wetting Phase 
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BOUNDARY CONDITIONS 

The Boundary Conditions define if a side of the sample (X-, X+, Y-, Y+, Z-, and 
Z+) is connected to a wetting phase reservoir or a non-wetting phase reservoir.  

If a side is not connected to a reservoir, e.g. if the porous medium continues in that 

direction, SatuDict determines pore sizes and checks connectivity using symmetric 
boundary conditions in these directions, i.e. the pore structure is mirrored at this 

side. 

Boundary conditions can only be entered if the chosen wetting model is not 
Equilibrium State (Imbibition I, i.e. Imbibition with invading fluid not connected to 

a reservoir). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By checking Minimal Pressure of Interest, the size of the original simulation 

domain (voxels) is artificially increased in the direction(s) of the flow (here Z). The 
effect is to improve the capillary pressure results at least down to the desired value, 
by increasing the structure size such that a sphere, corresponding to the minimal 

pressure, fits into the whole structure. The cost for this increased accuracy is that it 
is increasing the memory requirements for the calculations as well. 

The size of the increased Simulation Domain (in voxels) and the Estimated 
Required Memory for it are shown. 
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SOLVER PARAMETERS 

The Solver Parameters are Step Size, Interface Step Size, Write Steps to .gdt 
Files, Neighborhood Mode and Select Diameters. These parameters control the 
number of pressure steps computed, the format of the output files, and the 

connectivity rule, respectively. 

 

STEP SIZE (PORE DIAMETER) 

The pore size (together with the connectivity rule based on the Neighborhood Mode 

and the defined contact angles) determines the distribution of the wetting and non-
wetting phases.  

The pore sizes to be considered for the calculations can be defined by entering the 
Step Size. The algorithm increases or decreases the pore radius (and thus changes 
the capillary pressure) from step to step by this amount. Small values increase the 

accuracy of the result but lead to longer calculation times. 

INTERFACE STEP SIZE 

This feature is only available if the Dynamic Pore Morphology Method is used. It 

specifies how far the interface between the phases is allowed to move within one 
simulation step and like this influences the accuracy of the simulated capillary 
pressure curve. The Dynamic Pore Morphology Method tries to approximate the 

specified interface distance but, in some cases, smaller interface distances are 
realized. If the Interface Step Size is small, then the accuracy and thus the number 

of simulation steps is increased but it also increases the overall runtime. 

WRITE STEPS TO .GDT FILES 

If Write All .gdt is selected, the computed phase distributions are also saved as 
GDT files that can be imported at any time for visualization. The file names saved as 
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GDT contain the name of the experiment and the corresponding pore size, defined 

by the entered Step Size (e.g. Imbibition_000000_d00001.00.gdt). 

The colors in which the Wetting Phase, the Residual Wetting Phase, the Non-Wetting 
Phase, and the Residual Non-Wetting Phase are displayed in the visualization are 

chosen automatically from the set of free material IDs. 

Depending on inlet and step size, different steps might lead to the same .gdt file. 

With Write Only Changed .gdt selected, only .gdt files that differ from previous 
ones are written to the hard drive. This leads to a reduced hard drive memory 
consumption and a slightly reduced runtime. 

Select Write No Files if no intermediate .gdt files should be saved. 

NEIGHBORHOOD MODE 

The Neighborhood Mode determines how the voxels of the material occupying the 

pore space in the porous media are perceived as belonging to a connected group. 
Checking Face is more restrictive than choosing Face, Edge, or Vertex. 

See more details on the neighborhood mode in the GeoDict 2022 Base Reference 

and the ProcessGeo 2022 (Cleanse command) handbooks of this User Guide. 

SELECT DIAMETERS AND FIND MAX. 

The range of pore diameters that should be considered in the calculations is defined 

by the Select Diameters parameter. If the check box is enabled, then the minimum 
and maximum pore diameter can be entered.  

Click Find Max to find the maximum pore diameter. The value found by Find Max 

is inserted automatically in the right box. 

For Drainage selected as Experiment, only the minimum diameter can be set. If 

Imbibition is selected as Experiment, only the maximum diameter can be set.  

 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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CAPILLARY PRESSURE CURVE RESULT FILE 

Here, the case in which a wetting fluid (water) is displaced by a non-wetting fluid 
(oil) during Drainage (Drainage Process with WP-Residual and NWP-Reservoir) is 
shown. The calculations of capillary pressure curve are run on a porous structure 

(54% SVF, originated from Berea sandstone). 

After the solver has finished, the calculation results are immediately displayed in the 

Result Viewer and saved into a GDR (GeoDict Result) file in the chosen project folder 
(File → Choose Project Folder...). The entered Result File Name (here, 

CapillaryPressureDrainageII.gdr) appears at the top. The GDR file can be opened at 

any time by selecting File → Open *.gdr File…in the menu bar. 

The green dot in the right corner of the Result Viewer indicates that it contains the 
results computed for the structure currently in memory and showing in the 

Visualization area (here in 2D cross-section view). 

 

The GDT files corresponding to the computation steps for the chosen wetting model 
(Drainage_000000_d00125.00.gdt, etc.) are stored in the automatically created 

collapse and expand 

collapse and expand 
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folder CapillaryPressureDrainageII in the project folder (if Write All.gdt was 

selected on the Solver Parameters tab, see page 16). This folder also contains the 
PressureSaturation.pas file, necessary for the visualization, and the Structure.gdt 
file, with the original structure, before the drainage simulation is started.  

 

 

At the bottom of the result file window, several buttons are available: 

 

◼ Manage Data:  

▪ Clean-Up/Pack: Zip the information contained in the result folder or clean-
up the result folder. 

▪ Rename: Change the name of result file and result folder. 

◼ Click Load Input Map to re-enter (in the SatuDict GUI) the options and 
parameters that were used for the calculation results displayed in the result file.  

◼ Export: Export the results for postprocessing with another tool 

• Excel (generic): Export the information of the section Result Map of the 
GeoDict result file to Microsoft Excel®. You can analyze computation results in 

Microsoft Excel® using GeoDexcel provided with GeoDict. See the GeoDexcel 
handbook for more information.  

• Excel (generic) – Python: Export the information to an .xlsx Excel file in the 
same way as with Excel (generic), but using a Python script. This export does 
not need an Excel installation and can therefore also be used on Linux systems. 

• Excel (specific): Export the information of the result file to Microsoft Excel® 
to use the predefined chart and analysis options for SatuDict results. See page 
26 and the GeoDexcel handbook for more information. 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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• Matlab: Open Matlab® if an installation and license is available, change to the 

project folder, and load the result file with GeoLab. See the GeoLab handbook 
for more information. 

• Store As Html: Export the information shown in the Results tab to a html 

file. 

• Save Plots: Export all plots to the GeoDict result folder. See the Result Viewer 
handbook for more information. 

• Input Map as Python: Export the solver options and material parameters 
used for the computation, together with the computation command to a Python 
file. This file can be executed as a GeoDict macro to rerun the computation, 

see the Automation handbook for more detailed information. 

 Close the Result Viewer by clicking Close. 

In the Result Viewer, the computational results are accessed through tabs: Input 
Map, Log Map, Post Map, Results, Data Visualization, Create Videos and 
Metadata. 

INPUT MAP 

The Input Map provides a simplified overview of all data entered in the Wetting 
Parameters dialog box.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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LOG MAP 

The Log Map provides information about the solver runtime, the memory usage and 

the hardware. 

 

 

 

 

 

 

 

 

 

 

 

 

POST MAP 

The Post Map provides information about the plots shown under the Results tab. 
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RESULTS 

Report 

When clicking the Results - Report subtab, a detailed table with the calculated 

values is shown. 

For a typical capillary pressure result file, the table shows the Saturation of the non-
wetting phase (NWP), the Saturation of the wetting phase (WP), as well as the Pore 

Diameter, the Mean Curvature and the calculated corresponding Capillary Pressure 
for every step (pore size). If the Dynamic Pore-Morphology Method with the option 

Non-Monotonic Capillary Pressure was used for the computation, Mean Curvature 
and Capillary Pressure are shown both for the monotonic and non-monotonic 
capillary pressure curve. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Warnings in the Result File: 

If the Contact Angle Method Multiple Contact Angle was used for the computation 
of the saturation pressure curve (see page 12), a warning may appear in the result 

file created. 
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The reason is that the defined contact angle for the wetting phase is high and the 
diameter of pores in the structure is high compared to the diameter of components 

of the structure.  

Two main ingredients of the multiple contact angle method are a dilation and an 

erosion process. For high contact angles, the erosion radius can get much higher 
than the dilation radius. For solid objects in the structure with diameter much smaller 

than the maximum pore diameter, this can lead to artefacts in the fluid distribution, 
like contact angles higher than desired, larger saturation steps and fewer saturation 
steps. This happens if the ratio between pore diameter and diameter is larger than 

2 ∗
cos (𝜃)

1−cos (𝜃)
. With the new True Contact Angle method, this problem can be avoided. 

Plots 

Click the Results - Plots subtab to observe the tabular results of the Report subtab 
as a chart showing Saturation and Pressure values.  

At the left side of the Result Viewer, the user can modify the way the graph is 
displayed by selecting Graph Type (Pressure over Saturation, Saturation over 

Pressure), Phase Selection (Non-Wetting Saturation, Wetting Saturation), 
Saturation Unit (1, %, mL) and Reference Volume (Pore Space, Total Sample 
Volume). 

As usual, right clicking on the plot opens a small dialog box with the possibility to 
modify the axis settings, the graph styles or to save the graph in different ways. 

With Edit Axis Settings, e.g., the scale of the X- and Y-axis can be changed to 
compare plotted results from different capillary pressure curve calculations side by 
side. 

From GeoDict 2022 on, the options Edit Axis Settings and Edit Graph Styles, can 
be accessed also by choosing Plot Options→Pressure-Saturation at the bottom 

of the left panel. 

At the beginning of the drainage process, the porous structure is saturated (100%) 

by the WP when the initial pressure is low. As the pressure increases, the Oil as NWP 
starts invading the structure and forces the water as WP out of it.  

By the end of the drainage process, the structure is saturated with Oil as NWP (17% 

Water as residual WP vs. 83% Oil as NWP) and the pressure is at its highest level. 

The non-monotonic increase of the pressure value for the simulation with the 

Dynamic Pore-Morphology Method is visible, especially for saturation values between 
70% and 80%. 
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Check Invert Saturation in the left panel, to show the values on the X-axis in 

decreasing instead of increasing order. 

Map 

The Results - Map subtab gives access to the computed values.  

For the capillary pressure curve, it lists the calculated Pressure, Diameter, and 

Saturation values. The name of the *.pas (pressure and saturation fields) solution 
file for the visualization of results is also given. The WettingPhaseID (here, 0 is 

Water) and NonWettingPhaseID (here, 2 is Oil) show the assigned material IDs of 
the wetting fluid and non-wetting fluid, respectively. 
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Analyzing Capillary Pressure Curves with GeoDexcel 

At the bottom of the Result Viewer, click Export → Excel (specific) to directly enter 

the computational results into a customized Microsoft Excel® spreadsheet.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The data are automatically organized as needed to chart the results. The data 

included under the Results- Report subtab in the Result Viewer can be found by 
scrolling down in the Microsoft Excel® spreadsheet.  

Click the M2M tab in the menu bar, and then, click Create GeoDict Charts.  

 

In the dialog box, select e.g. Capillary Pressure Curve (non-wetting phase) 

from the list and Active Worksheet as the origin of the data and click Create 
Chart.  
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The Capillary Pressure Curve (non-wetting phase) data is plotted in a line chart 

on top of the spreadsheet. This chart corresponds to the plot shown when selecting 
the Results - Plots subtab of the CapillaryPressureDrainageII.gdr file. See page 
23.  

 

 

 

 

 

 

 

 

 

Charts for the Capillary Pressure Curve (wetting phase), the Saturation (non-
wetting phase), or the Saturation (wetting phase) are also possible. 
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DATA VISUALIZATION 

A wide array of visualization options is possible in GeoDict, from which the user can 
select those that fit for the computations of a particular module. 

For SatuDict, it makes sense to observe the progress of the drainage (or imbibition) 
process and the step-by-step images of these processes. 

VISUALIZATION OF THE DRAINAGE PROCESS 

Under the Data Visualization tab, click Load to access the pressure and saturation 

field data saved in the PressureSaturation.pas file. Then, choose the components 
whose results can be visualized: Pressure and Saturation (NWP). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The values of pressure and 
saturation of the NWP in the 

drainage solution file (.pas) are 
loaded.  

 

 

 

 

The initial display, in 2D view or 3D rendering, is done using visualization defaults 
that the user can modify to visualize the imbibition and drainage results obtained 

with SatuDict. These parameters can be found under the Volume Field tab in the 
Visualization panel, above the Visualization Area. For more information on a 

particular visualization setting, see the Visualization handbook of this User Guide. 

A color bar or color scale appears in the Visualization area near the structure during 
the visualization of the results, indicating the gradation of pressure or saturation.  

https://www.geodict.com/Support/UserGuide.php?lang=en
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Switch between the two components of the results (Pressure, Saturation (NWP)) 

through the Color By pull-down menu.  

While in 3D rendering, the progress of the drainage process can be followed by 
selecting Pressure from the Color By and Saturation (NWP) from the Threshold By 

pull down menus.  

 

With these settings, the visualization is twofold because, for a given NWP saturation 

level (threshold value), the capillary pressure at particular locations in the structure 
is shown together with the distribution of the two phases. While the color gradation 
refers to the capillary pressure values as displayed in the color bar, the distribution 

of the phases is given by the presence or absence of colored voxels in the pore space, 
without relation to the color bar scale. 

For this dual visualization of capillary pressure level and distribution of phases, the 
interplay of Threshold slider and Clip Mode selection are essential: 

◼ Threshold slider / box 

The drainage process is observed when moving the threshold slider from left to 
right or entering decreasing values from 0 to 1 in the clip box. This parallels the 

decreasing saturation of WP (from 100% to 0%) in the porous structure. 

The beginning of the drainage process is observed with the slider all the way 
to the left (Saturation NWP: 0, i.e. 0%, Saturation WP: 1, i.e. 100%). At this 

point, the pressure is low, and the NWP has not begun displacing the WP.  

By moving the slider to the right or by entering increasing values in the threshold 

slider box, the drainage process is visualized forward, with the NWP displacing 
the WP and invading the structure.  

The drainage process is at the end when the clip slider is finally all the way to 
the right, i.e. the WP has been displaced and the NWP occupies the structure. 

Observe, that in the example shown here, the solution was computed till a 

saturation of 83%. 

◼ Clip Mode: makes the dual visualization of pressure values and distribution of 

phases possible because it links them based on the capillary pressure saturation 
curve (see page 23). 

◼ By selecting , color is shown in the pore space where NWP invades the 
structure only for a saturation higher than the Saturation (NWP) set in the 

threshold slider. This shows the locations where the WP is still in the structure 
at this saturation or below. 

◼ By selecting , color is shown in the pore space where the NWP is already 

present for a saturation below the value for Saturation (NWP) set in the 
threshold slider. This shows the locations where the NWP has already invaded 
the structure and replaced the WP. 
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The following are two examples of the effect of setting the Threshold slider/box and 

Clip Mode during the visualization of the results in the PressureSaturation.pas file.  

 

 

20% NWP 

   

 

  

 
 60% NWP 
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In contrast to the visualization of the drainage process, the imbibition process is 

visualized backwards after running an imbibition experiment with SatuDict and 
obtaining a result file. By moving the Threshold slider to the left or entering 
decreasing values in the Threshold box, the NWP is being displaced from the 

structure by the WP.  

VISUALIZATION OF FREEZE-FRAME SHOTS OF DISPLACEMENT 

Finally, use the CapillaryPressureDrainageII.gdr to visualize step-by-step the 

displacement of NWP by WP in the porous structure during drainage from GDT files 
saved during the capillary pressure curve calculation.  

To analyze these images, make sure that the visualization of the Structure is 

switched on (View → Structure, in the menu bar).  

Select one of the GDT files that are saved for every simulation step. The file names 

correspond to the inscribed pore diameter and capillary pressures. For example, the 
file Drainage_000030_d00045.00.gdt is the image of the structure at the step 

corresponding to a pore diameter of 45 voxels (and a capillary pressure of 6694 Pa).  

Click Load gdt to open the desired file from the CapillaryPressureDrainageII 
folder, inside the project folder. The image from that step is displayed.  
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The GDT file for largest pore size (here: Drainage_000000_d00125.00.gdt, Pressure: 

2410 Pa) corresponds to the beginning of the drainage process. The structure 
appears (almost fully) saturated by WP.  

The GDT file for a smaller pore size (here: Drainage_000048_d00029.00.gdt, 
Pressure: 10388) corresponds to an intermediate part of the drainage process. The 
structure appears partly saturated by the NWP and the residual WP is visible.  

 

 

 

 

 

 

 

 

 

CAPILLARY PRESSURE WITH HYSTERESIS EFFECT 

A generalization of the pore 

morphology method, available 
since GeoDict 2020, allows 
considering structures in which the 

invading fluid is already present in 
the structure. This allows the 

simulation of primary and 
secondary drainage experiments, 

as well as primary and secondary 
imbibition experiments.  

The image on the right shows a 

typical graph for primary drainage, 
imbibition, and secondary 

drainage. 
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After the primary drainage simulation shown in pages 18ff. with the result file 

obtained, perform a follow-up imbibition simulation where the WP displaces the NWP.  

First, the final state of the previous drainage simulation is loaded 
(Drainage_00098_d00001.00.gdt with 301242 Pa). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Then, return to the main GeoDict GUI and click the Solver Options’ Edit… button 
in the SatuDict section to select the wetting parameters for the capillary pressure 

curve simulation. 

Change the name for the result file from CapillaryPressureDrainageII.gdr to 

CapillaryPressureImbibitionIII.gdr.  

Under the Saturation Experiment tab, set the Experiment to Imbibition and check 
Invading Fluid must be connected to a reservoir as well as Replaced fluid can 

leave a residual. 

In the Constituent Materials tab, select the Invading Fluid to be Water (Water is 

labelled as Wetting Phase). Automatically, the Replaced Fluid is set to be Oil. Click 
Run in the SatuDict section to start the simulation. 
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The Result Viewer of the result file opens at the end of the computations. Load the 
GDT files as explained in pages 31ff. to visualize the imbibition process. 

Observe that, step-by-step, the oil is replaced by invading water, which reconnects 
with the water previously trapped in the structure (dark blue Residual Wetting Phase) 
from the earlier drainage simulation.  
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CREATE VIDEOS 

On the Create Videos tab, a .mp4 file with an animation of the drainage or 

imbibition process can be created. Follow the steps listed on the right panel: 

1. Make sure that you are in 3D mode 

2. Set the colors of solid and fluid materials to your preferred ones 

3. Choose your favorite camera position 

Select Edit Parameters to change the capillary pressure result file as input for the 

video creation. 

Select Open Macro File to open a text editor with the python file used for the video 
creation.  

 

 

 

 

 

 

Click Create Video, to create the video 

capillaryPressureVideo.mp4 in the result file 
folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The video shows the capillary pressure curve on the right, and the changing 
distribution of wetting and non-wetting phase during the saturation simulation on 

the left. For a better visualization, only part of the structure is shown.  

If the video was created successfully, the grayed-out Video not available button, 

is enabled and changes to a Play Video button.  
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RELATIVE PERMEABILITY 

When selecting Relative Permeability from the pull-down menu in the SatuDict 
section, the Solver Options needed for running this computation can be entered 

(or modified) through the Edit... button.  

 

In the Relative Permeability Parameters 

dialog, the name for the result file is entered in 
the Result File Name (*.gdr) box. Keep the 

default name or rename it according to your 
current project to differentiate the results of 
SatuDict computations. The resulting GDR file is 

placed inside the chosen project folder (File → 

Choose Project Folder, in the Menu bar). 

 

The Relative Permeability Parameters are grouped under the Wetting 
Parameters, Constituent Materials, Boundary Conditions, and Solver tabs. 
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WETTING PARAMETERS 

PHASE DISTRIBUTION 

The calculation of phase distribution can be based on the pore size alone (by Pore 
Size), corresponding to the Saturation Experiment Imbibition with Invading Fluid 
must be connected to a Reservoir unchecked, as applied in the Capillary Pressure 

Curve calculation (page 10). 

However, it can be taken from a previously simulated imbibition or drainage process 

by checking from simulated wetting process and clicking Browse... to choose a 
result file (GDR file) in your project folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SATURATION STEPS 

The rates of saturation of the non-wetting phase in the porous media, for which the 
permeability is to be calculated, can be set in the Saturation (non-wetting phase) 
table.  

There are three different modes to select the saturations: 

◼ Guess: 

◼ If the Phase Distribution is set to by Pore Size, the saturation steps are 
chosen uniformly based on the number of saturations specified in the box.  

◼ If the Phase Distribution is set to from simulated wetting process, the 

saturation steps are chosen from the provided GDR file. An internal selection 
process tries to find representative saturation steps based on the saturation 

and capillary pressure. 
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◼ All is only available when the Phase Distribution is set to from simulated 

wetting process. Then all saturation steps provided in the GDR file are used. 

◼ Manual: In manual mode, the table can be modified at will, and the desired 
saturation steps can be entered. 

FLOW PHASE 

In the Flow Phase panel, choose the phase (Wetting Phase and/or Non-Wetting 
Phase) for which the Relative Permeability is to be calculated. 

CONSTITUENT MATERIALS 

Under the Constituent Materials tab, the Invading Fluid and Replaced Fluid can 
be entered. The tab is very similar to the one for capillary pressure (see page 15) 

but some properties cannot be entered (e.g. surface tension). 

If the phase distribution under the Wetting Parameters tab is chosen by pore size, 

the replaced fluid must be present in the structure. If it is taken from simulated 
wetting process, then both fluids can be changed and do not have to be already 
present in the current structure. 
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BOUNDARY CONDITIONS 

COMPUTATION DIRECTIONS 

For the Computation Directions, choose the direction of the calculated flow. To 
obtain the whole 3x3 permeability matrix in the result file, it is necessary to choose 
all three directions. 

BOUNDARY CONDITIONS IN FLOW DIRECTION 

The Boundary Conditions in Flow Direction can be checked to be Periodic or 
Symmetric. Periodic boundary conditions are recommended for periodically 
generated structure models and for non-periodic structures with high porosity. 

After checking Periodic boundary conditions in flow direction an inflow region (also 
called inlet) and outflow region (also called outlet) can be automatically added by 

checking Add implicit region and entering its size in voxels. The default added 
implicit inflow is 10 voxels and implicit outflow is 10 voxels. The inlet and outlet are 
essential to avoid the possibility of closing the flow channels when the structure is 

periodically repeated. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SOLVER  

Internally SatuDict solves several equations for values of permeability at each voxel 

by using an iterative solver. The basic idea of an iterative method is to:  

1. Start with some initial guess for the unknown values. 

2. Improve the current values in each iterative step. The improvement can be fast 
or extremely slow depending on problem parameters, 

3. Repeat the iterative process until one of the stopping criteria occurs. 
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For Relative Permeability, the three flow solvers EJ, SimpleFFT, and LIR are 

available and can be chosen from the pull-down menu. For structures with low 
porosity, the SimpleFFT or LIR flow solver should be used for best performance, 
i.e., low runtimes. 

EJ 

The EJ solver is assigned to compute the flow fields and relative permeability after 
selecting EJ from the pull-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The iterative process is controlled by setting the values and activation for Tolerance, 

Residual, Maximal Iterations, Maximal Run Time (h). The stopping criterions 
can be enabled and disabled by the check boxes. The additional Error Bound 

stopping criterion is available for LIR and SimpleFFT only. 

The default and recommended stopping criterion is Tolerance for the EJ solver. The 
Tolerance stopping criterion looks for stagnation of the method when the process 

becomes stationary. This occurs when from iteration to iteration the improvement in 
the permeability value becomes extremely small.  

By setting the stopping criterion to Residual, the computations terminate as soon 
as the relative norm drops below the selected residual threshold. This stopping 
criterion is only available for SimpleFFT and EJ. 

The option to Stop Relative to Fully Saturated Permeability alters the chosen 
stopping criterion such that for low saturated states the solver stops relative to the 

result of the computation where the structure was fully saturated. The fully saturated 
structure has the highest permeability and decreases when lowering the saturation. 
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For low saturation states the permeability is almost zero and the computation is 

much more expensive. This option significantly speeds-up the overall runtime and 
stops the solver earlier for low saturation states while keeping the overall quality of 
the result relative to the highest permeability. 

The Relative Permeability solver allows setting the maximal number of steps 
(Maximal Iterations, default value is 100000) or the maximum run time (Maximal 

Run Time, default 240 h). However, when the solver stops because the Maximal 
Iterations value or the Maximal Run Time / (h) has been reached, no guarantee 
on the quality of solution can be given.  

Parallelization 

Calculations can be parallelized if the user’s license and hardware allow it. The 
threads of the program can be executed concurrently. The Parallelization Options 

dialog box opens when clicking the Edit... button, to choose between Local, 
Sequential, Local, Parallel or Local, Maximum. When Local, Parallel is chosen, 
the number of Processes to run can be entered. And Local, Maximum sets the 

number of used processes to the maximum possible number, restricted by the 
hardware and number of licensed processes. 

 

The choice of Cluster is for Linux users with floating licenses only. See the High 
Performance Computing handbook for information on how to setup GeoDict such that 
these options can be used.  

Discard PDE Solver Files 

The files with results (*.gdr) of the permeability computations are saved in the 
chosen project folder (File → Choose Project Folder, in the Menu bar). An 

additional directory with the same name is created to keep the intermediate 

computation files (PDE solver files).  

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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Checking the Discard PDE Solver Files box causes the erasing of all intermediate 

computation files, log-files, flow fields etc. stored in this folder. While having the 
benefit of saving storage place, discarding these files has also the effect of disabling 
the 3D visualization of the results. Only the result file *.gdr is saved. 

Solver Type 

For the flow computation with EJ solver, five different ways to implement no-slip 
boundary conditions of the flow solver are available: EJ-Stokes, EJC-Stokes, EJ2-

Stokes, EJC2-Stokes, and FFF-Stokes. 

 

The implementations describe how the no-slip boundary conditions are discretized, 
i.e., at which discrete point the tangential velocity reaches zero. 

The default EJ-Stokes (Explicit Jump-Stokes solver) sets the tangential velocity to 

zero at the center of the voxel surfaces. It is a newer implementation of the Finite 
Volume solver that solves moderately slower, but it is noticeably more accurate for 

low porosity structures.  
EJC-Stokes sets the tangential velocity to zero at the voxel corners. 
EJ2-Stokes sets the tangential velocity to zero at the center of the voxel surfaces 

and uses a 2nd order approximation of the velocity field. 
EJ2C-Stokes sets the tangential velocity to zero at the voxel corners and uses a 

2nd order approximation of the velocity field. 
FFF-Stokes sets the tangential velocity to zero at the voxel centers. 
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SIMPLEFFT 

The SimpleFFT solver is assigned to compute the flow field after selecting SimpleFFT 

from the pull-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The explanations given in pages 40ff for the EJ solver, regarding Stopping 

Criterion, Stop Relative to Fully Saturated Permeability, Parallelization, and 
Discard PDE Solver Files apply also here for the SimpleFFT solver. 

The recommended stopping criterion is Error Bound for the SimpleFFT and the LIR 
solver. The Error Bound stopping criterion uses the result of previous iterations and 

predicts the final solution. The solver stops if the relative difference with respect to 
the prediction is smaller than the specified error bound.  

Thomas Algorithm 

For Thomas Algorithm, Automatic, NotUseTdma or UseTdma can be selected. 

The tridiagonal matrix algorithm (Tdma) can help to improve the convergence for 
structures with high porosity and therefore speedup the computation with 
SimpleFFT. With UseTdma / NotUseTdma it can be switched on or off. Choosing 

Automatic makes the selection based on the porosity of the structure and on the 
partial differential equation for the flow solver. For Stokes equation, used in the 

Relative Permeability computations in SatuDict, Tdma is always switched off for 
Automatic selected. 
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Velocity and Pressure Relaxation 

The balance between stability and speed of the simulation can be specified by the 
Velocity relaxation and Pressure relaxation: Stable  Fast slide bars. The 

parameter has to be greater than 0.0 and less or equal to 1.0. Setting the balance 

of Stable versus Fast is a trial-and-error process. There is no general rule to 
optimize it but in most cases a value of 1 for both relaxation parameters is optimal. 

LIR 

The explanations given in pages 40ff. for the EJ solver, regarding Stopping 

Criterion, Stop Relative to Fully Saturated Permeability, Parallelization, and 
Discard PDE Solver Files apply also here for the LIR solver. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Write Compressed Volume Fields 

The LIR solver uses a very memory efficient adaptive grid structure for flow 
simulations. If the option Write Compressed Volume Fields is checked, the 

adaptive grid structure is used as compression method for writing out velocity and 
pressure (VAP) files to the hard drive as well.  
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This option allows to save 80-90% space on hard drive. The runtime for writing VAP 

files is also reduced significantly. But the runtime for loading and uncompressing of 
compressed VAP files is increased by the amount of runtime that was saved for 
writing out compressed VAP files. 

If the option Write Compressed Volume Fields is not checked then the usual 
regular grid is used for writing out VAP files. 

Use Multigrid Method 

The main idea of Multigrid is the usage of multiple coarser adaptive grids to speed 
up convergence behavior but requires only little more memory. The Multigrid 
Method is explained in more detail in the section Solver Options of the FlowDict 

2022 handbook of this User Guide. 

Use Krylov Method 

The Krylov subspace method can reduce the runtime of the LIR solver significantly. 

Since this is not always the case, dependent on the structure and boundary 
conditions, and since it needs more memory, the method can be switched on and 
off. Choose for Use Krylov Method Enabled or Disabled to use the method or 

switch it off. Select Automatic for an automatic selection based on the structure 
and the chosen boundary conditions. If Automatic is used, the relaxation parameter 

will be chosen automatically by the solver as well. 

Relaxation 

The Relaxation parameter for the LIR solver is very similar to the Velocity 
relaxation and Pressure relaxation for the SimpleFFT solver. The balance 

between stability and speed of the simulation can be specified by the Relaxation. 
The parameter must be between 0 and 2. The default value is 1 and usually provides 

the best balance between stability and speed.  

If the relaxation value is greater than 1, the solver needs less iterations and less 
runtime, but this cannot be applied for all kinds of structures. If the relaxation value 

is smaller than 1, the solver needs more iterations and more runtime, but the 
simulation is more stable. To solve the Stokes equations, the Relaxation value 

never needs to be smaller than 1. 

Optimize for, Grid Type, and Grid Refinement 

The Optimize for, Grid Type, and Grid Refinement parameters are special options 
for the LIR solver. The defaults are already optimal for most applications.  

A detailed explanation of these parameters can be found in the section Solver 
Options of the FlowDict 2022 handbook. 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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RELATIVE PERMEABILITY RESULT FILE 

Here, the results of the computation of the relative permeability of a partially 
saturated porous material with 17% porosity (83% SVF) are shown. The Wetting 
Phase was selected as the flow phase (Wetting Parameters tab), and relative 

permeability was calculated in Z-direction (Boundary Conditions tab). Computations 
were run using the LIR solver. 

After the solver finishes, the calculation results immediately open in the Result 
Viewer and are saved into a GDR file in the chosen project folder with the entered 
Result File Name (here, RelPermeabilityWP_LIR.gdr). 

 

The results are accessed through the Input Map, Log Map, Post Map, Results, 
Data Visualization, and Metadata tabs 

INPUT MAP, LOG MAP, AND POST MAP 

The values under the Input Map, Log Map, and Post Map tabs are analog to those 
for the Capillary Pressure Curve result file (see pages 18ff.). 

 

 

Expand and collapse 
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RESULTS 

Report 

Under the Results-Report subtab, the Relative Permeability (dimensionless 

relative permeability) and Effective Permeability (saturation-dependent 
permeability) tables are shown for the chosen WP saturation rates (here, 0.25, 0.50, 
0.75) and the start and end saturations (0.0 and 1.0) in the chosen computation 

directions (here, K13, K23, K33 for the computation in Z direction). The chosen 
saturation rates are approximated as good as possible (here, 0.25, 0.49, 0.75). 

Having selected the Wetting Phase as the flow phase under the Wetting Parameters 
tab, it is the permeability depending on the saturation of the flowing WP that is 
shown in the tables.  

The relative permeability at 0% and 25% WP saturation is zero in z-direction, 
indicating that before the structure is 49% saturated with the WP, there is no path 

for the flow. The directions for which computations have not been carried out appear 
as unknown in the permeability tables.  

 

Plots 

In the Results - Plots subtab, the values of the Relative Permeability or 

Effective Permeability table are shown in a graph.  

On the left side, the user can modify the way the graph is displayed by selecting the 
Graph Type (Permeability over Saturation, Saturation over Permeability), the 

Phase Selection (Non-Wetting Saturation, Wetting Saturation), the Permeability 

Relative permeability (0 to 1) 

Effective permeability / m2 
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Unit (Effective permeability in m2, Relative permeability between 0 and 1), and 

the Saturation Unit (1, %, mL). Click Apply to change the graph shown according 
to the options selected. Choose Plot Options, to change axis and graph settings. 

 

Map 

Under the Results - Map subtab, the computed values are listed.  
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DATA VISUALIZATION 

Under the Data Visualization tab, the .gdt and .vap files, corresponding to the 

saturation levels computed, can be opened, as explained above in pages 31ff. Here 
shown is the GDT file for a 49% WP saturation level.  

The solid phase (Quartz) is shown together with the Non-Wetting phase (Air) and 

the Wetting phase (Water). The upper part of the image shows the velocity field of 
the WP (Water) with transparent effect on the clipped structure model.  

A detailed explanation of the procedure to obtain this kind of visualization can be 
found in the Visualization handbook. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EXPORT OF RESULTS 

The result file RelPermeabilityWP_LIR.gdr can be loaded into a Microsoft Excel™ 

spreadsheet with GeoDexcel in the same way as explained above (pages 26f.) for 
the analysis of the capillary pressure curve. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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RELATIVE GAS DIFFUSIVITY 

When selecting Relative Gas Diffusivity from the pull-down menu in the SatuDict 
section, the Options needed for running this process can be entered (or modified) 

through the Edit... button.  

 

 

 

 

 

 

 

 

The name for the result file is entered in the Result File Name box. Keep the default 

name (RelDiffusivity.gdr) or rename it according to the current project. 

Clicking the Wetting Parameters, Constituent Materials, Boundary 
Conditions, and Solver tabs, the parameters necessary to run the Relative Gas 

Diffusivity calculations can be entered. 
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WETTING PARAMETERS 

The wetting parameters for the calculation of the Relative Diffusivity are the same 
as seen above (pages 37f.) for the Relative Permeability.  

Only one of the phases can be set as the phase for that the diffusivity is computed 

(Flow Phase). 

CONSTITUENT MATERIALS 

The Constituent Materials tab for the calculation of the Relative Diffusivity are 
analogous to those seen above (page 38) for the Relative Permeability. 

BOUNDARY CONDITIONS 

For the Computation Directions, choose the direction of the calculated flow. To 
obtain the whole diffusivity matrix in the result file, it is necessary to choose all three 

directions. 

When computing the relative gas diffusivity, Boundary Conditions must be entered 
for the computations of the diffusion solver.  

If Periodic is checked, the solution is computed assuming that the structure is 
periodically repeated in the diffusion direction(s).  

If Dirichlet is checked, a constant concentration is ensured along both border planes 
in the diffusion direction. The use of Dirichlet boundary conditions approximately 
doubles the computational costs.  

In most cases, the difference between these two settings is not significant and can 
be compared with a computational error. In general, we suggest using periodic 

boundary conditions, as the computation time is longer. In few situations, due to the 
structure’s geometry, using Dirichlet boundary conditions is unavoidable.  
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SOLVER  

The parameters for the calculation of the relative gas diffusivity under the Solver 
tab are the same as for the EJ solver for the computations of the Relative 
Permeability (see pages 40ff.). The options Stop Relative to Fully Saturated 

Permeability and Solver Type are not available for the diffusivity computations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Checking Analyze Geometry enables the geometrical analysis of the structure 
model if the user deems it necessary.  

When checked, the analysis is carried out before the solver computations to 
determine the existence of a through path, and to fill up unconnected empty spaces. 
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RELATIVE GAS DIFFUSIVITY RESULT FILE 

Here, the results of the computation of the relative diffusivity of a partially saturated 
porous media with 17% porosity (83% SVF) are explained.  

The Wetting Phase was selected as the flow phase (Wetting Parameters tab), and 

the relative diffusivity was calculated in z-direction with Dirichlet boundary conditions 
(Boundary Conditions tab). 

After the solver has finished, the calculation results are immediately displayed in the 
Result Viewer and saved into a GDR file in the chosen project folder (File → Choose 

Project Folder...). The entered Result File Name (here, RelDiffusivityWP.gdr) 

appears at the top. 

In the result files for the Relative Gas Diffusivity, the computational results are 
organized into and are accessed through the Input Map, Log Map, Post Map, 

Results, Data Visualization and Metadata tabs. The values under these tabs are 
analog to those for the Capillary Pressure Curve result file (see pages 18ff.). 

Under the Results-Report subtab, the Relative Diffusivity table (saturation-
dependent diffusivity) is shown for the chosen saturation rates (0.00, 0.25, 0.49, 

0.75, 1.00) in the chosen directions (here, D13, D23, D33 for the diffusion in z -
direction). The chosen saturation rates are approximated as good as possible. The 
Wetting Phase was selected as the flow phase in the Wetting Parameters dialog box. 

Thus, it is the diffusivity depending on the saturation of the WP that is shown in the 
Relative Diffusivity table. 

 

 

 

Observe how, similar to what occurred with the relative permeability, the diffusivity 

is zero at 0% and 25% saturation of the WP, indicating that before the structure is 
49% saturated with the WP, no through path of the WP is available.  
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In the Results-Plots subtab, the values in the Relative Diffusivity table of the 

Report tab are shown in a graph.  

On the left panel, the user can modify the way the graph is displayed by selecting 
Graph Type (Diffusivity over Saturation, or Saturation over Diffusivity), Phase 

Selection (Non-Wetting Saturation, Wetting Saturation), and Saturation Unit (1, 
%, mL).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The RelDiffusivityWP.gdr result file that opens at the end of the computation is 
saved in the project folder, together with the RelDiffusivityWP result folder. The 
result folder contains various files for the saturation levels entered in the wetting 

parameters dialog box.  
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Among these files, the GDT and HHT files (containing the concentration values) can 

be opened on the Data Visualization tab.  

Click Load .gdt and .hht  to load the structure for a certain saturation of the WP 
and the corresponding concentration field in the same way as explained in pages 

31ff. for the relative permeability results. 

 

 

 

 

 

 

 

 

 

 

 

 

The result file RelDiffusivityWP.gdr can be loaded into a Microsoft Excel™ 

spreadsheet with GeoDexcel in the same way as explained above (pages 26f.) for 
the analysis of the capillary pressure curve. 
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RELATIVE THERMAL CONDUCTIVITY 

When selecting Relative Thermal Conductivity from the pull-down menu, the 
Options needed for running this process can be entered (or modified) through the 

Edit... button.  

 

The name for the result file is entered in the Result 

File Name box. Keep the default name 
(RelConductivity.gdr) or rename it according to 

your current project. 

Clicking the Wetting Parameters, Constituent 
Materials, Boundary Conditions, and Solver 

tabs, the parameters necessary to run the Relative 
Thermal Conductivity calculations can be entered. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WETTING PARAMETERS 

The wetting parameters for the calculation of the Relative Thermal Conductivity are 

the same as seen above (pages 37f.) for the Relative Permeability. No Flow Phase 
needs to be selected for thermal conductivity computations. 
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CONSTITUENT MATERIALS 

Under the Constituent Materials tab, the Wetting Phase fluid (in the Pore space), 
all constituent materials of the structure, and the Non-Wetting Phase fluid can be 
selected and their thermal conductivity (W/(m K)) can be defined. Many materials, 

together with their thermal conductivity values, are available in the GeoDict Material 
Database. Other materials or fluids can be added to the material database and saved 

together with their user-defined thermal conductivity. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For materials defined as Manual, thermal conductivities can be defined directly on 
the Constituent Materials tab. Isotropic, Transverse Isotropic or Orthotropic 

thermal conductivities can be defined. The properties of the invading fluid appear 
above the thermal conductivity tab. The replaced fluid must be present in the current 
structure. 
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BOUNDARY CONDITIONS 

The choice of Boundary Conditions and the selection of Computation Directions 
for the calculation of the Relative Thermal Conductivity are the same as seen above 
(pages 51) for the Relative Diffusivity. 

SOLVER 

The parameters for the calculation of the Relative Thermal Conductivity under the 

Solver tab are the same as for the EJ solver for the Relative Permeability (see pages 
40ff.). The options Stop Relative to Fully Saturated Permeability and Solver 
Type are not available for thermal conductivity computations. 

Checking Analyze Geometry enables the geometrical analysis of the structure 
model if the user deems it necessary.  

When checked, the analysis is carried out before the solver computations to 
determine the existence of a through path, and to fill up unconnected empty spaces. 
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RELATIVE THERMAL CONDUCTIVITY RESULT FILE 

Here, the saturation-dependent effective thermal conductivity is computed at various 
NWP saturation levels (0%, 25%, 50%, 75%, and 100%) for two structures, both 
with 70% porosity, but different constituent materials. The WP is water, and the 
NWP is air. The relative thermal conductivity is calculated in z-direction. 

In the first experiment, the only fiber material in the structure is 100% polyamide 
PA6 (Material ID 01, grey).  

In the second experiment, the structure is made of 20% polyamide (Material ID 
01, grey) and 80% polypropylene (Material ID 02, brown) fibers  

 

 

 

 

 

 

 

 

 

 

PA6 and PP have different thermal conductivities. 

The selected materials and their thermal conductivities are entered under the 
Constituent Materials tab by selecting them from the material database (here 

shown for PA6+PP). The thermal conductivity of the materials included in the 
database is automatically considered. For other materials, the material database can 

be edited, or the thermal conductivity can be entered manually. 
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After the computations for the first experiment and the second experiment are 

finished, the Result Viewer opens. The result data contained in the result file are 
visible below when the file names are highlighted in the Header section box.  

 

Both result files, from the first experiment and the second experiment, can be 
selected and highlighted by using Shift-click on the list of file names 

(RelConductivity_PA6.gdr and RelConductivity_PA6+PP.gdr). Then, the results are 
shown side-by-side. 
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By highlighting the names of both result files and clicking the Combine Results 

button, the results of both files are combined and saved into a GDR file in the chosen 
project folder. The combining process enables post-processing on the combined 
results.  

The combined result file contains the Input Map, Log Map, Post Map, Results and 
Compare Maps tabs. The Results – Report subtab, shows the names of the files 

that were used to create the combined result file (RelConductivity_PA6.gdr and 
RelConductivity_PA6+PP.gdr).  

Plots from the original result files are merged into one plot and shown under the 

Results - Plots subtab. More information on combining result files and comparing 
their plots can be found in the Result Viewer 2022 handbook of the User Guide. 

In the combined plot, the Relative Thermal Conductivity of the structures (Y-axis) 
increases with increasing saturation levels of water (WP). The relative thermal 

conductivity of the PA6+PP structure is always lower.  

The parameters for the graphs can be modified (see pages 23f.) in the Result Viewer 
of the original result files before combining them. The modification of the plot 

settings can be synchronized in both original files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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The HHT files (homogenized heat file; containing the temperature distribution) 

corresponding to the five saturation levels entered under the Wetting Parameters 
tab (0.00, 0.25, 0.50, 0.75, 1.00) are stored for each computation in the result 
folder, here RelConductivity_PA6 and RelConductivity_PA6+PP, in the project 

folder. 

Under the Data Visualization tab, click Load .gdt and .hht, to access the .hht files 

and visualize the results.  

This is similar to opening GDT files (see pages 31ff.) for the visualization of the phase 
distribution for results of Capillary Pressure Curve and Relative Permeability directly 

from the result file (GDR). 

For example, open the RelConductivity_PA6_p0_s0.256122_z.hht file that 

corresponds to a 25% NWP saturation in Z-direction from the experiment with the 
100% PA6 structure.  

 

 

 

To better observe the results, clip the structure (in 3D Rendering) or switch off the 

visualization of the structure (in 2D cross-section, View → Structure in the menu 

bar), and adjust the Color Map values in the Visualization panel.  

Observe how the heat is distributed in the structure.  
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RESISTIVITY INDEX (RELATIVE ELECTRICAL CONDUCTIVITY) 

When selecting Resistivity Index from the pull-down menu, the Options needed 
for running this computation can be entered (or modified) through the Edit... button.  

 

The name for the result file is entered in the 
Result File Name box. Keep the default name 

(RelElectricConductivity.gdr) or rename it 
according to your current project. 

 

 

 

Under the Wetting Parameters, Constituent Materials, Boundary Conditions 
and Solver tabs, the user enters the parameters necessary to run the calculations 

to obtain the Saturation Exponent, Cementation Exponent, the (saturation-
dependent) Resistivity Index, Normalized Electrical Conductivity, and Relative 
Electrical Conductivity. All parameters are similar to those explained for the Relative 

Thermal Conductivity computation starting on page 56. 
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WETTING PARAMETERS 

The wetting parameters for the calculation of the Relative Electrical Conductivity (and 
the Resistivity Index from it) are the same as seen for the computation of the 
Relative Thermal Conductivity (page 56). 

CONSTITUENT MATERIALS 

Under the Constituent Materials tab, the Wetting Phase fluid (in the Pore space), 

all constituent materials of the structure, and the Non-Wetting Phase fluid can be 
selected, and their electrical conductivity (S/m) can be defined. Many materials, 
together with their electrical conductivity values, are available in the GeoDict Material 

Database. Other materials or fluids can be added to the material database and saved 
together with their user-defined electrical conductivity. 

Electrical conductivities can only be entered for materials present in the structure 
currently in memory (displayed in the Visualization area). For Manual materials, 
values for Isotropic, Transverse Isotropic or Orthotropic electrical conductivity can 

be defined directly on the Constituent Materials tab. The electrical conductivity of the 
invading fluid is shown on top of the other material properties and can be changed 

there if the material is set to Manual (Fluid).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BOUNDARY CONDITIONS 

The choice of Boundary Conditions and the selection of Computation Directions 
for the calculation of the Relative Electrical Conductivity are the same as seen for 

the Relative Diffusivity (page 51) and the Relative Thermal Conductivity. 
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SOLVER OPTIONS 

The parameters for the calculation of the Relative Electrical Conductivity under the 
Solver tab are the same as for the EJ solver seen above (pages 40f.) for the Relative 
Permeability. The options Stop Relative to Fully Saturated Permeability and 

Solver Type are not available for electrical conductivity computations. 

Checking Analyze Geometry enables the geometrical analysis of the structure 

model if the user deems it necessary.  

When checked, the analysis is carried out before the solver computations to 
determine the existence of a through path, and to fill up unconnected empty spaces. 
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RESISTIVITY INDEX RESULT FILE 

Here, the resistivity index is computed at various NWP saturation levels (0%, 25%, 
50%, 75% and 100%) for a porous medium with 17% porosity. The invading fluid 
is brine (5 S/m, WP) and the replaced fluid is air (0 S/m, NWP). The relative electrical 
conductivity is calculated in Z direction. 

 

In this experiment, the only solid material in 

the structure is the non-conductive material 
quartz (Material ID 01), with 0 S/m.  

 

The selected materials and their electrical 
conductivity are entered under the 

Constituent Materials tab by selecting them 
from the material database. The electrical 
conductivity of the materials included in the 

database is automatically considered. For 
other materials, the material database has to 

be edited or the electrical conductivity can be 
entered manually.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After the computations are finished, the Result Viewer of the result file opens, and 
the results are saved into a GDR file in the chosen project folder (File → Choose 

Project Folder...). In this example, the RelElectricConductivity.gdr result file is 
saved in the project folder together with the RelElectricConductivity result folder.  

The computational results are accessed through the Input Map, Log Map, Post 
Map, Results, Data Visualization, and Metadata tabs (see pages 18ff.). 
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Under the Results - Report subtab, the tables for Saturation Exponent, 

Cementation Exponent, Resistivity Index, Normalized Electrical 
Conductivity, and Relative Electrical Conductivity are shown for the chosen 
saturation rates (0.25, 0.5, 0.75) and the start and end saturations (0.0 and 1) in 

the directions for which results were calculated. 

The values of the Resistivity Index table are the inverted values of the 

Normalized Electrical Conductivity table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Under the Results - Plots subtab, these values are shown in graphs.  

The parameters of the graphs can be changed as seen in pages 23f  

By right-clicking inside the graph and opening the Edit Axis Settings dialog box, 

the range and scaling of the y-axis can be changed. 
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The interpretation of the result tables and the visualization of the corresponding 
created files are like for the results of the Relative Thermal Conductivity, see 

page 62. 
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PREDEFINED 

When Predefined is selected in the SatuDict section, predefined computation 
settings can be chosen from the pull-down menu in the Predefined panel: 

Hysteresis, Mercury Intrusion Capillary Pressure, Resistivity Index Thin Film 
Model, and Trapping Curve. 

These Predefined SatuDict computations are also accessible directly from the menu 
bar as one of the GeoApps. 

 

 

 

 

 

 

 

The SatuDict Predefined are macros 

or scripts containing combinations of 
SatuDict commands with certain 
default parameters to mimic 

experiments or real observations. 
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ADD PREDEFINED COMPUTATIONS 

When predefined computations are run, the corresponding GeoDict macros are called 

and executed. These macros can be accessed with the Open Macro / Script File 
button, alternatively they are available in the SatuDict folder in the GeoDict 

installation folder. In Windows: 

 

They can be opened with a text editor to check or edit the syntax of the computation 
steps. To add predefined computations, put the corresponding macros in this folder 
and restart GeoDict. 

EDIT AND EXECUTE PREDEFINED COMPUTATIONS  

By clicking the Edit... button, the corresponding parameter dialog box opens and the 
parameters defining the corresponding saturation experiments are displayed and can 

be modified.  

Click OK to close the dialog, and then Run to execute the computation. 
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FORCED IMBIBITION – CAPILLARY PRESSURE 

This script allows to simulate the 
capillary pressure curve in the case 

of mixed wettability of the 
considered structure e.g. if the fluid 
phases are water and oil. Both 

spontaneous and forced drainage 
and imbibition can be simulated, as 

shown in the figure on the right.  

GeoDict predicts a capillary pressure 

hysteresis cycle with 

1. Primary drainage simulation 
2. Spontaneous and forced 

imbibiton 
3. Spontaneous and forced 

drainage simulation. 
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The wetting-phase contact angle for up to four materials at the start of the simulation 

can be defined. After the drainage simulation, the app will turn some of the water-
wet grain surfaces (i.e. where the contact angle is less than 90°) into oil-wet surfaces 

(i.e. where the contact angle is larger than 90°) where oil is in contact with a grain 
surface. Like this, water is non-wetting for this part of the structure for the following 

imbibition simulation. Check Turn Oil-Rock Contact into non-wetting phase and 
define now the contact angles larger than 90° for water. 

The simulation uses the Dynamic Pore Morphology Method. Start and End Hysteresis 

Cycle can be defined, and the computation of Non-Monotonic Pressure Curves can be 
selected. The tooltips in the Forced Imbibition – Capillary Pressure Parameters 

dialog show a more detailed explanation of the parameters selectable. 

To compute the relative permeability for the combined imbibition process, check this 
option at the bottom of the dialog or compute the relative permeability later with the 

predefined script Forced Imbibition – Relative Permeability, see page 72. 

FORCED IMBIBITION – LOAD STRUCTURE 

This script adjusts Material IDs and Material Colors to forced imbibition script defaults 
upon loading geometries (*.gdt). 

Like all Forced Imbibition 

scripts, it is dedicated to oil 
and water setups! 

 

 

 

 

 

 

 

FORCED IMBIBITION – RELATIVE PERMEABILITY 

This script performs relative permeability computations for mixed wettability 
imbibition results obtained via the predefined function Forced Imbibition – 

Capillary Pressure, see page 71. 
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HYSTERESIS 

The Hysteresis predefined computation performs a Hysteresis simulation of the 
SatuDict functionalities Drainage and Imbibition (both with invading fluid connected 

to a reservoir and the replaced fluid can leave a residual) in succession. 

 

After clicking Edit…, enter 

the Hysteresis Result File 
Name, Number of Cycles, 

Interfacial Tension, and 
Contact Angle.  

Additionally, the Wetting 
Phase and Non-Wetting 
Phase can be chosen and 

whether to start with 
Drainage or with Imbibition.  

If Use Dynamic Pore 
Morphology is checked, the 
parameters for this method 

can be defined. 

Tooltips describe all those 

options in more detail. 

 

 

 

 

 

 

 

 

 

 

 

After the Predefined - Hysteresis has finished, the Result Viewer opens. The Header 
section box lists all the Imbibition and Drainage result files of each cycle. The 
hysteresis result file is an automatically combined result file showing the Pressure-

Saturation curves in a single plot.  
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MERCURY INTRUSION CAPILLARY PRESSURE 

The Mercury Intrusion Capillary Pressure predefined computation sets the 
simulation settings for a Drainage experiment, without residual of the replaced fluid 

(Drainage I, see page 11), from SatuDict to recreate the Mercury Intrusion 
Porosimetry (MIP) experiment. During the experiment, the structure’s pore space is 
being invaded by mercury from all six sides. 

After clicking Edit…, the Result File Name can be changed. If Use Dynamic Pore 
Morphology is checked, parameters for this method can be defined.  

 

 

 

 

 

 

 

 

 

 

 

 

After the predefined simulation is finished, the Result Viewer opens showing the 
results from SatuDict Drainage simulation as seen on pages 18ff..  

The saturation table and the capillary pressure curve are seen under the Results – 

Report and the Results – Plots tabs. 
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RESISTIVITY INDEX THIN FILM MODEL 

The Resistivity Index Thin Film Model predefined computation accounts for thin 
water films on the mineral phase(s) by computing the effective fluid properties for 

voxels containing oil and the water film. This model simulates a drainage with oil as 
the non-wetting phase and subsequently computes the resistivity index. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After clicking Edit…, it is possible to modify the Result File Name, Water Layer 
Thickness, Phase Conductivities, Number of Saturation Steps, Tolerance, 

Number of Threads and the Contact Angle.  

If Use Dynamic Pore Morphology is selected, parameters for this method can be 

defined as well. 

Tooltips describe all those options in more detail. 

Results for the electrical conductivity computed, are shown in the same way as 

explained on page 66ff. 
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TRAPPING CURVE 

The Trapping Curve predefined computation computes the trapping curve for the 
currently loaded structure and the given contact angle.  

Initially, the entire pore space is set to water before air invades during a primary 
drainage simulation. For the Number Of Saturations defined in the Trapping Curve 
Parameters dialog, imbibition processes are simulated for different gas saturations 

and the residual gas saturation is computed. 

 

 

 

 

 

 

 

 

 

 

 

 

A Project Name Prefix for the result files created can be set in the Trapping Curve 
Parameters dialog, as well as the Contact Angle, Interfacial / Surface Tension 

and the Minimum Initial Gas Saturation. 

If Use Dynamic Pore Morphology is selected, parameters for this method can be 
set as well. 

In the Results – Plots tab of the Result Viewer, the Residual Gas Saturation is plotted 
over the Initial Gas Saturation. In the Results - Report tab, a table with the 

corresponding values is available. 
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